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Tutorial One:

Comparison of 
Printer Profiles

For this project use a standard i-Star target produced on both glossy and 
bond paper.  Create a custom-made profile for glossy paper and apply it to 
both prints.  Use the dimensions 25 rows by 32 columns.  The “Examples” 
folder contains i-Star screen captures of both prints.  The purpose of this proj-
ect is to analyze and quantify the deviations between print on plain paper to 
that on glossy paper.

Initially, collect the necessary data using an appropriate tool.  The spec-
tral data supplied in the “Examples” folder has been collected using Gretag 
Macbeth Spectrochart Lite software and Gretag Macbeth’s Spectrolino spec-
trophotometers.  Because spectral data is supplied, instructions for data col-
lection are omitted.  Guidelines for data collection can be found in specific 
instrument and software manuals.

Now, begin this project.
 
Start i-Star

Click on the i-Star executable file.  For convenience, create a shortcut to 
the i-Star application on the desktop.  See (Fig. 1).

Create a new project.

Fig. 1
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i-Star will process and report the file on the “Data Layout” page.   A warn-
ing will appear requiring additional information. See (Fig. 3).

This warning means the data collecting software did not report the number 
of columns and rows in the output file.  To resolve this, fill out the “Number of 
Rows” and “Number of Columns” fields.  See (Fig. 4).  The originating data 
targets contain 25 rows and 32 columns each.

Enter the number of rows and columns in the appropriate fields.  
Press “Proceed” button

Press Ctrl + n or choose “New Project” in the “Project” menu.  A request 
for a reference measurement will appear.  See (Fig. 2).  The reference mea-
surement is considered the “ideal” or starting point.  In this case, choose 
Glossy Photo Paper with its appropriate printer profile as the reference mea-
surement.

Choose glossy[glossy].xls in the open file dialog. 

Fig. 2

Fig. 3
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i-Star will interpret the data contained in the file and evaluate the param-
eters for all predefined regions of interest.  Unless the option is disabled, a 
message to check (and possibly reassign) the color map values of the target 
will appear.  See (Fig. 5). 

The color map values may be changed on the “Project Color Map” tab of 
the “Preferences” page.  See (Fig. 6).

Fig. 4

Fig. 5
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Press F2 or choose “Preferences” in the i-Star menu.
Navigate to “Project Color Map” tab.
.

i-Star has several ways to interpret extreme values of L.  Ideally, on images 
representing the entire L band, readings of L values range between 0 and 100.  
In reality, only values close to these are achievable.  The first option, “De-
fined by user,” allows manual setting of these values reasonable for the test. 
“Defined by image” will analyze the image and assign values automatically. 
Finally, “Defined by map,” evaluates the percentage of patches from the target 
for each L extreme and computes the mean value.  Depending on  project pref-
erences and the necessity for repetition of the test, choose one setting.  Keep 
in mind, only the first and last choices offer a basis for cross-examination of 
projects.

In this example, use the “Defined by map” option and calculate the Lmin 
and Lmax values from the first percentile of extreme L values.

Choose “Defined by map” for both black and white patches.  
Click the “Mark Extreme” button for a value of 1%.
Apply changes. 

The i-Star targets offer a broad selection of hues and tones.  Specify regions 
for evaluation.  For this test, the main regions of interest are the complete data 
set, neutrals, and near neutrals.  Additionally, evaluate the differences between 
the patches with Lmin and Lmax.  Many of these regions are mathematically 

Fig. 6
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defined by the i-Star application, but spatial redefinition may be useful when 
printing profiles are not calibrated perfectly.

Navigate to “Project Crops” tab.

The chart in Fig. 7 show which patches are contained in each of the cre-
ated regions.  The top left is a custom crop of skin tones, bottom left are near-
neutrals and neutrals.  The Lmax crop patches are found at the top right and 
Lmin crop patches at the bottom right.

First, create the region including skin tones.  Skin tones are located in the 
last four columns of the target.  Double-click on any of those patches.  This 
will demarcate the patch with an “X.”  All patches marked with an “X” will 
be included in the region of interest.  To simplify the process, select the entire 
region for inclusion in the custom crop, and click on the “Mark selected” but-
ton.  

Select the last four columns of target.
Click “Mark selected” button.

Fig. 7
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Now that all necessary patches are marked, save them as a region of inter-
est - or in this case, a custom crop.  “Custom crops” are spatially defined target  
regions of interest.  The term “region of interest” refers to mathematically 
defined regions in a test target.  See (Fig. 8).

Click “Add” button.
Enter “cc_skintones” in the box.  See (Fig. 9).

To complete the process, continue with the remain-
ing three groups of patches from the target. Name 
them “cc_neutrals,” “cc_lmax,“ and “cc_lmin.”    

The remaining files have identical geometry as the initial file, so safe ac-
tivation of the Data Import Assumptions (DIA) engine is possible.  The DIA 
engine will make assumptions about the size and measuring parameters of the 
“import to” target based on the reference file for the i-Star project.  Conse-
quently, before employing the DIA, verify that the data is compatible.  Data 
may not be compatible if it was gathered using several different measuring 

Fig. 8

Fig. 9
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devices (or software).  The check boxes in the “Data import options” section 
will assist in verifying that all data meets necessary criteria for accurate com-
parison.  See (Fig. 10).

Navigate to “Data import options” sub-tab on “General” tab.
Activate all assumptions, and select the sequence of patches left-to-right.
Deactivate “Import only user confirmed data” option.  

Activation of the “Import only user confirmed data” option allows for ad-
ditional modifications from the “Data Layout” page after completion of the 
DIA engine cycle.

 
Now return to “Project Description” page.
Press F2 or choose “Preferences” in the i-Star menu.

Because i-Star calculates results based on parameters set on the “Prefer-
ences” page, any data-related change requires a recalculation of the values.  
Because the color  map was modified, recalculate the averaged data for the 
project.  See (Fig. 11).

   
Press F7 or select “Recalculate Project” in the “Project” menu.  
A completion message will appear.

Fig. 10



8Comparison of Printer Profiles

Printer Profile Tutorial Tutorial 1 (Rev. 2010-01-01)

Press Ctrl + a or choose “Add to Project” in the “Files” menu.
Choose bond[glossy].xls in the open file dialog.  See (Fig. 12).

i-Star will process the file and report on the “Data Layout” page.  Return to 
the “Project Description” page.

Now that all files have been imported, the data is ready for analysis.  Be-
fore analysis, check the “Target Model” window.  This window shows a visual 
representation of the imported data and must look exactly like the target used 
for collecting the data.  

Press Ctrl + t, or select “Target Model Window” in the “View” menu.

The target window now shows the reference target (i.e. the print on glossy 
paper with the printing profile for glossy paper).  This window offers a number 
of controls all described in the i-Star User Guide.  The first control changes 
the file (and the corresponding target) represented by the image on the screen. 
See (Fig. 13). 

Fig. 11

Fig. 12
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View the bond paper target model.
Select “bond[glossy].xls” in the first drop down list.  See (Fig. 14).

The second drop down list modifies the region of interest/custom crop 
represented in the “Target Model” window.  View the “General Skintones” 
region.

Fig. 13

Fig. 14
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Select “glossy[glossy].xls” in the drop down under “Files.”  See (Fig.15).
Select “General Skintones“ in the drop down under “Regions of interest.”

Fig. 15

The grid on the “Target Model” window can be turned on or off at any 
time.  To toggle the appearance of the grid, simply press “g”.

Now that all data has been imported properly, close the “Target Model” 
window.  In some instances, the “Target Model” window will be opened much 
sooner.  For example, data sets imported from multiple measuring systems 
and associated software will require the “Target Model” window.

  
Press g.
Close “Target Model” window.

Next, consider the project charts.  i-Star provides a number of easy chart-
ing options which may include spectral and hue angle distributions, i-Star 
component development and results, tonal reproduction charts, and compo-
nent histograms.  Custom specifications of the charts is possible, so becoming 
familiar with the manual entries on factors will lead to greater efficiency.  The 
“Chart” window consists of a single page with the “Settings” and “Chart” tabs. 
The “Chart” tab contains the chart and a lower panel with controls.  Right-
click any unused surface on the lower panel to access the chart selection menu 
containing choices for all available charts.  The “Settings” tab contains all 
controls for the appearance of charts.  The individual groupbox titles indicate 
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settings for the charts.

Press Ctrl + g or choose “Charts Window” from “View” menu.

This project considers change in I*total, I*tone, I*color, Δe2000, hue an-
gles, and L values.  The regions of interest include the complete data set, neu-
trals, and near neutrals.  Additionally, evaluation of differences between the 
patches with Lmax and Lmin will occur.  See (Fig. 16).

Navigate to “Settings” tab.
In the “I*Component Results and Averaged Parameter Development” 

check I*total, I*tone full, I*color full, Quality Control for both I*tone and 
I*color, Brightness Factor full, and Contrast Factor full.

Navigate to “Chart” tab.  Check “Show legend” box.

Fig. 16

The chart window will allow easy interpretation of both measurement and 
trend lines.  See (Fig. 17).  Click each point and the status bar will show the 
corresponding file and x,y coordinates.
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Take a moment to observe the changes indicated by the chart: the Con-
trast Factor full is 69.172 and the Brightness Factor full is at 91.347; I* full 
is 63.592, I*tone 60.525, and I*color full is 56.841.  Additionally, there are 
0.580% falsely encoded patches according to I*tone and 3.500% according to 
I*color.

i-Star can also analyze data for any chosen color space region of interest.  
Consider the region of dark skin tones as defined in the template.

Select “Dark Skintones” in “Regions of Interest” drop down list.

Fig. 17
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Fig. 18

The skin patches on the bond paper print are significantly degraded.  The 
value of I*color is as low as 25.633 with as much as 8.108% falsely encoded 
patches.  This indicates that the skin tones have deteriorated significantly, and 
as much as 8.108% of the patches have a hue angle shift greater than 60º in 
the LAB color space.  See (Fig. 18).

These results suggest a check of the spectral distributions for some skin 
tone patches.  Use the i-Star spectral distribution charts for this analysis.

Right-click on the panel and select “Spectral Distribution” in the context 
menu.

Change the column value to 30 and row value to 19.

Notice when observing the spectral distributions of both prints that the 
print on bond paper has reduced reflectance in both the extreme high and low 
ranges of the visible spectrum - mainly hues of magenta, red, and orange.  Be-
cause skin tones consist mainly of red and magenta hues, it is understandable 
with higher spectral reflectance of blues that the bond paper printout would 
have a washed out look in the skin tones region.  In addition to the chart, the 
two compared patches are indicated (or in a multi-file project, the patches 
from first and last files).  See (Fig. 19).
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Experiment with other row/column values and observe the spectral distri-
bution changes.

Finally, save your project.  Saving allows access to data easily without 
having to reenter any information.  i-Star will save the complete set of data, a 
snapshot of the settings, and results of all calculations.  Please note that i-Star 
will not save any open windows or generated graphs, so export either of these 
items before closing the window.

Although i-Star saves all project data entered in the i-Star application, as a 
further safeguard against data loss, keep the original source files and periodi-
cally back up all i-Star projects.

Press Ctrl + s or select “Save Project” in “Project“ menu.
A “save file” dialog will appear.  See (Fig. 20).

Fig. 19
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Choose a file name for the project. 
Click “Save” button.

WIR i-Star contains a custom report creation utility, allowing the creation 
of PDF reports for the analyzed data.  This tutorial shows the steps taken to 
create a standard WIR report using the i-Star application.

Click “PDF Report Preview Window” under “View” menu. See (Fig. 21).

Fig. 20

Fig. 21
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The Summary page of the PDF Report Preview window will appear.  See 
(Fig. 22).  The first page on the PDF will contain a summary of the project 
details.  The filename text box shows the name of the PDF.  Choose a name for 
the project.  In this example, use ‘WIR_report_2007_12_13.pdf.’  The three 
remaining check boxes and text boxes designate the location of the PDF file. 
For this example, place the PDF in the same folder as the project by placing a 
check next to ‘at project folder.’  The remaining entries, colored white, must 
be filled from the “Preferences” page under the “Project Info” tab (See page 
14).  These fields are available to include more details about the nature of the 
project.

Fig. 22
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The check boxes on the right side of the “PDF Report Preview” show 
which pages are included in the current ‘Report Preset’ selection (in this case 
‘Wilhelm Imaging style short’).  The buttons to the right of the check boxes 
allow  preview of the pages before printing the PDF.  A green check indicates  
current viewing of the page.  Check each button to view the pages of the PDF. 
The screen capture on page 15 shows a preview of the ‘Test info’ page.

Fill the “Printer,” “Ink,” and “Media” text boxes and the supplemental in-
formation box.  See (Fig. 23).  Check the Wilhelm Imaging style (short) radio 
button.  This is the preset reporting format used for a standard Wilhelm Imag-
ing Research report.  The text boxes colored in white must be filled from the 
“Preferences Page.”

Fig. 23
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View the “Test Information” page of a standard WIR i-Star Report.  Notice 
that for this test, the “Light level (Lux)” is left empty because this data is not 
important for this test.  The light level has no effect on the comparison results 
between the two prints.  The light level fields become relevant when using i-
Star to analyze the exposure of an image to elements (e.g. light, ozone, etc.). 
An example defining conditions, time of exposure, and periodic readings of 
an image is explained in another tutorial.

 A detailed explanation of each page and its corresponding text field is in-
cluded with the main i-Star User Guide.  

After reviewing the PDF preview, click “Create PDF Report” button to 
print the PDF. 

Fig. 24
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Continue exploring i-Star.  Explanations of other controls, including those 
for the “Main Settings” page are available in the User Manual.  When finished, 
press Ctrl + q or choose “Quit” from the “i-Star” menu.  Save any additional 
changes to the project.


